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Introduction

This chapter provides detailed explanations of all available Eudora functions.

Creating an Outgoing Message

An outgoing message is a message you send to someone else.  

To create an outgoing message, select New Message from the Message menu.  A new 
composition window entitled <<No Recipient>>, <<No Subject>>  is displayed with the 
blinking insertion point situated at the start of the To: field.  The composition window 
consists of the title bar, the icon bar, the message header, and the message body.

Icon Bar

Title Bar

 Message
Header

Message
Body

The composition window

Title Bar

The title bar provides information about incoming and outgoing messages, including the 
name of the sender (if it is an incoming message) or addressee (if it is an outgoing 
message), the time and date the message was delivered or sent, and the message subject.  
New messages are labeled <<No Recipient>>, <<No Subject>> until they are sent or 
queued.  Messages get time stamps when they are sent, or if they are queued for timed 
delivery.

Icon Bar

The icon bar consists of a series of objects that are displayed just under the composition 
window title.  It allows you to control your message’s priority, override some of your 
preference settings for that message only, and send or queue the message.  There is one 
popup menu and five icons.  Each of the five icons may be turned on or off for the current 
message by clicking on it.  A check mark symbol appearing next to the icon denotes that 
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the icon has been turned on.  The popup menu and icons are described below.
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The Icon Bar

Note: The default settings for the icon bar are determined in the Switches... 
dialog (see the “Switches... Dialog” section).

Priority/Attachment Type Popup
The leftmost object in the icon bar is the Priority/Attachment Type popup menu. 

Priority/Attachment Type popup menu

The Priority portion of this popup menu is on top.  If you want to indicate that 
your message is of a higher or lower priority than a normal message (blank), use 
this menu to make the desired selection.  Priorities are discussed in the “Message 
Priorities” section.

The Attachment Type portion of this menu allows you to select what format 
documents that you attach to outgoing messages are encoded in:  AppleDouble, 
AppleSingle, or Bin Hex.  AppleDouble is best for recipients with Multipurpose 
Internet Mail Extensions (MIME); AppleSingle is best for sending applications or 
other Macintosh-specific files; and Bin Hex is most compatible with old 
Macintosh mailers and previous versions of Eudora.

The Always As Documents option should be selected when sending attachments 
between Macintoshes, as this keeps the attachments in their original Macintosh 
format.  However, when sending a document to another platform, de-selecting this 
option allows Eudora to convert the attachment into the format most likely to be 
understood by other platforms.

Signature
If this icon is checked, your signature file is automatically attached to the end of 
each message you send.  Signatures are discussed in the “Creating a Signature” 
section.

Word Wrap
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If this icon is checked, a carriage return is not required at the end of each line you 
type in an outgoing message; Eudora automatically wraps text to the next line, 
with line breaks at roughly 76 characters per line.

Tabs in Body
If this icon is checked, hitting the [tab] key within the message body results in 
Eudora inserting enough spaces to move the insertion point to a multiple of 8 
characters from the start of the line.  This mimics the way tabs work on many 
terminals. If this icon is not checked, hitting the [tab] key returns the cursor to the 
To: field of the message header.

Note: This icon also controls the handling of tabs in text that is pasted into the 
message window and in plain text attachments that are sent as documents (not 
binhexed).  If Tabs in Body is checked, tab spacing is replaced by blank spaces; 
otherwise, the tabs are included in the text.

Keep Copy 
If this icon is checked, a copy of each sent message is kept in the Out mailbox 
(their summaries are marked with an “S” in the far left column of the Out mailbox 
window, indicating that they have been sent).  These messages are saved until 
they are deleted or transferred to a different folder.

Quoted-Printable Encoding
If this icon is checked, quoted-printable encoding may be used when sending 
messages that contain long lines of text or special characters.  When selected, it is 
used for all plain text attachments.  It is recommended that this icon always be 
checked.

Send or Queue
If the Immediate Send option in the Switches... dialog is turned on, the rightmost 
button in the icon bar is labeled Send.  Clicking the Send button immediately 
sends the message.  Otherwise, this button is labeled Queue, and has the same 
function as the Queue for Delivery command under the Message menu (upon 
clicking this button, the message window closes and the message is held in the 
Out mailbox, marked ready for delivery).
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Message Header

Outgoing message headers consist of six fields:  To:, From:, Subject:, Cc:, Bcc:, and 
Attachments:.  Each field holds a different piece of information.  The To:, Subject:, Cc:, 
and Bcc: fields can be directly edited.

To move the insertion point from field to field, press the [tab] key or click in the desired 
field with the mouse.  When entering information into the fields, use the standard 
Macintosh text-editing tools provided under the Edit menu.  Here is a brief description of 
the intended contents of each field:

To:
The intended recipient’s E-mail address, or a nickname you have defined (see the 
“Creating and Using Nicknames” section).  Multiple addresses are allowed, but must be 
separated by commas.

From:
The sender’s E-mail address.  This is usually your POP account plus your real name.  You 
can use a return address other than your POP account by entering the desired address in 
the Return Address field of the Configuration... dialog (see the “Configuration... Dialog” 
section).

Subject:
Brief text indicating the contents of the message.  This field can be left blank (though it is 
a breach of E-mail etiquette to do so).
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Cc:
E-mail address or nickname of person to whom a copy of the message is to be sent.  
Multiple addresses are allowed but must be separated by commas.  This field may be left 
blank.

Bcc:
“Blind” carbon copy.  Like addresses listed in the Cc: field, addresses listed here receive 
copies of the message.  Unlike addresses listed in the Cc: field, addresses listed here do 
not appear in the message header of the recipients.  This is useful when you want to send 
a copy of a message to someone without everyone else knowing you did so.  Multiple 
addresses are allowed but must be separated by commas.  This field can be left blank.

Attachments:
List of documents being sent along with the message.  Specify these through the Attach 
Document command under the Message menu (see the “Attachments” section).  To delete 
an attachment from a message, select it and press [delete].  You cannot enter information 
directly into this field.  This field can be left blank.

Message Body

After filling in the fields, move the insertion point to the space below the message header. 
Type the body of the message here.  Feel free to use the standard Macintosh text-editing 
tools provided under the Edit menu (see the “Summary of Menu Commands” section).

If the Word Wrap icon on the icon bar is checked (or the Word Wrap option in the 
Switches... dialog is turned on), you don’t need to press [return] at the end of each line of 
text.  The text wraps to the next line automatically.  If this option is not set, be sure to 
type a [return] at the end of each line or your message may not be legible on the 
recipient’s computer.  To use tabs in the message body, check the Tabs in Body icon in 
the icon bar.

Saving an Outgoing Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard when 
typing long messages, or so you can return to it later to edit or add more text.  

To save the message while the outgoing message window is open, select Save from the 
File menu.  The message window does not close, but the current version of the message 
is saved in the Out mailbox.  You might notice that the title appearing at the top of the 
message window changes from <<No Recipient>> << No Subject>> to what you typed 
in the To: and Subject: fields of the message.

If you now close the message (by clicking the close box in the upper left-hand corner of 
the message window, or by selecting Close from the File menu), it can be re-opened 
from the Out mailbox for further changes.  As with any message summary listed in a 
mailbox window, it can be identified by the contents of its To: and Subject: field. A small 
black dot, or bullet, to the left of a message summary listed in the Out mailbox indicates 
that the message is being indefinitely held there and is queueable.  Such messages remain 
in the Out mailbox until they are queued and sent or deleted.
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A sendable message saved in the Out mailbox

If you try to close an outgoing message window without specifically saving that version 
of the message, an alert is displayed asking if the message should be saved or the changes 
discarded.  If you select Discard and the message has never been saved, the message is 
deleted. 

Closing an unsaved composition window

Sending A Message

One-Step Send

If the Immediate Send option in the Switches... dialog is turned on, select Queue for 
Delivery from the Message menu to immediately send a current message. 
Alternatively, the rightmost button appearing in the icon bar at the top of the current 
message window is labeled Send.  Click this button to send the current message.

Clicking the Send button

If the Show Progress option in the Switches... dialog is turned on, a progress window is 
displayed momentarily at the top of the screen indicating the progress of the transmission. 
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Progress Window

Two-Step Send

Some people may prefer to compose many messages and transmit them all at once.  This 
is only possible if the Immediate Send option in the Switches... dialog  is turned off. 

To accomplish the first step for any outgoing current message,  select Queue For 
Delivery from the Message menu.   Alternatively, the rightmost button appearing in the 
icon bar at the top of the current message window is labeled Queue.  Click this button to 
queue the current message for later delivery.

Clicking the Queue button

Either of these selections closes the message window (if it was open), saves the message 
in the Out mailbox and marks it as queued, meaning ready to be delivered.  Queued 
messages are marked by a “Q” in the far left-hand column of the Out mailbox.

A Queued message in the Out mailbox

For the second step, select Send Queued Messages from the File menu.    This sends 
the queued message (or messages).  If the Show Progress option in the Switches... dialog 
is turned on, a progress window is displayed momentarily at the top of the screen 
indicating the progress of the transmission. 

Timed Messages

It is possible to tell Eudora to send a message at some specific time in the future.  To do 
this for the current outgoing message, select Change Queueing... from the Message 
menu.  The Change Queueing... dialog is then displayed.
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Change Queueing dialog

If you choose Right Now, the message is sent immediately upon clicking the OK button.  
If you choose Next time queued messages are sent, the message is sent the next time 
queued messages are sent.  If you choose On or After, you can use the time and date 
fields to fill in the time when the message should be sent.  The message is saved in the 
Out mailbox with a Q in the status column, just as if it were a normal queued message.  
However, the message is not actually sent until the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be running 
when the message is due to be sent.  If Eudora is not running, the message  
is sent the first time Eudora is run after the selected time has passed.

Sending Queued Messages on Check

If the Send on Check option in the Switches... dialog is turned on, every time a manual or 
automatic mail check occurs, all queued messages are sent, thus saving you the step of 
selecting Send Queued Messages.  

Quitting with Queued Messages

If you quit Eudora after you have queued messages, but without sending them using Send 
Queued Messages, Eudora gives you the opportunity to send the messages before you 
quit.

Quitting with queued messages

If you quit with timed messages, and the messages are due to be sent within the next 12 
hours, Eudora warns you and gives you the opportunity to send them.
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Quitting with timed messages

Editing a queued message

To edit a queued message, open the Out mailbox and double-click on the desired message 
summary to open its composition window.  Make the necessary edits and re-queue the 
new version of the message with the Queue For Delivery or Change Queuing... 
commands from the Message menu or the Save command from the File menu.  You may 
also re-queue the message using the Queue button on the icon bar.  The message is 
returned to the Out mailbox with a queued status.  If you close the changed message 
without choosing one of these, an alert is displayed asking you to verify the changes.  

Changing the Status of a Queued Message

A message that is queued but as yet unsent may be unqueued using the Change Queuing... 
command.  Open the Out mailbox and select the desired message summary.  Then, select 
Change Queueing... from the Message menu and click on Don’t Send.  This 
changes the message status from queued (Q) to saved (S).  The message is held in the Out 
mailbox until it is either deleted or re-queued and sent.  

Note: You can also send a message immediately or change it to timed send using  
the Change Queuing... command.

Keeping Copies of Outgoing Messages

Once a message is sent, it is put into the Trash mailbox unless the Keep Copies option in 
the Switches... dialog is turned on or the Keep Copy icon in the icon bar is checked.  In 
these cases,  the message is left in the Out mailbox and is annotated with an S in the 
status column of the Out mailbox indicating that the message has been sent.

Copies of outgoing messages saved in the Out mailbox
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Password Protection

There is password protection on mail checks to your account on the POP server.  Each 
time the Eudora program is opened, your password is requested prior to the first mail 
check, whether it is conducted automatically or manually.  If automatic checking is set 
(see the “Configuration... Dialog” section), a dialog requesting your POP server account 
password is displayed upon first opening Eudora.  If automatic checking is disabled, the 
same dialog is displayed at the time of your first mail check. 

Password dialog

Type in your password and click OK.  If you make a mistake before clicking OK, simply 
backspace and re-enter the password correctly.  

If your password is rejected, an error message is displayed indicating that you have 
entered the wrong password (see below).  Select Check Mail from the File menu to 
redisplay the password dialog.

Wrong password

Note: Remember that the Eudora password is "case-sensitive," so it must be 
typed in exactly or it is rejected.

As long as it is running, Eudora remembers your password.  If you don’t want it to 
remember (when, for example, you are away from your Macintosh), choose Forget 
Password from the Special menu.  At your next mail check you are prompted for your 
password again.  

Another password-related option is Save Password, which is in the Switches... dialog.  
This option makes Eudora remember your password from one session to the next (you 
NEVER have to enter your password again, even if you quit and restart Eudora).  This 
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option should only be used if your machine is in a secure location.
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Finally, the Change Password... command in the Special menu can be used to change 
your POP server password if your POP server machine is running a compatible password-
change server.  You’ll be asked to enter your old password once, and your new password 
twice.

Changing a password with Eudora

Note: For information on password-change servers, see Appendix A of this 
manual.

Checking For and Receiving Mail

The POP server is the machine where your mail is received and stored until it is 
transferred to the Eudora program on your Macintosh system.  Your POP server account 
is specified in the POP Account setting in the Configuration... dialog (see the 
“Configuration... Dialog” section).

Note: To best understand the functioning of the POP server with respect to 
Eudora, please see Appendix C.

There are two methods to check your designated POP server to see if you have new mail. 
One method is automatic and the other is manual.  Both methods deliver any mail 
addressed to you from the POP server to your Macintosh.  Before any checks are made, 
however, the POP server requests your account password.

Automatic Checking

Eudora automatically checks for mail if you tell it how often to do so.  From the Special 
menu, select Configuration....  The Configuration... dialog has a field entitled Check 
For Mail Every ? Minute(s).  Type in a value and Eudora automatically checks for mail at 
the desired interval whenever it is running (even if you are using other applications on 
your Macintosh).  For example, if you type in 15, Eudora checks for mail every 15 
minutes.  In fact, 15 minutes is a good minimum interval, as checking mail more 
frequently puts an unnecessary load on your POP server. 

Note: If automatic checking is set, the Check Mail command under the File 
menu displays the next time that an automatic check is scheduled to occur.

When Eudora does a mail check, you can be notified of new mail in one or all of four 
different ways: an alert dialog, a special sound, a flashing mail flag icon in the menu bar, 
or the opening of the In mailbox.  These options are turned on or off in the Switches... 
dialog (see the “Switches... Dialog” section).
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When you receive notice that new mail has arrived, select Eudora from the applications 
menu.  Mail always arrives in the In mailbox.  The messages are listed in the order they 
are received, with the most recent message listed last.

Unread messages in the In mailbox

If the In mailbox is not already open, select In from the Mailbox menu.  Unread 
messages are designated by a small black dot, or bullet, on the left side of the message 
summary.  Double-click anywhere on a message summary to open the message.  
Incoming messages are saved indefinitely in the In mailbox until they are deleted or 
transferred to another mailbox.

Manual Checking

You may check for mail manually at any time by selecting Check Mail from the File 
menu.  If you haven’t successfully entered your password since opening the Eudora 
program, you are prompted for it. 

If the Show Progress option in the Switches... dialog is turned on, the Progress window is 
displayed momentarily at the top of the screen as the POP server is checked.

The Progress window during a mail check

If there is no mail waiting at your account on the POP server, the You have no new mail 
alert is displayed.  Click OK.  You may check for mail again later.  

No new mail dialog

If there is a problem reaching the POP server, an error message alert is displayed.  To 
rectify the problem, review the POP server settings in the Configuration... dialog for 
correctness.
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Error while checking mail

If there is new mail, it is transferred automatically from the POP server to Eudora on your 
Macintosh system.  If the Show Progress option in the Switches... dialog is turned on, a 
progress window is displayed at the top of your screen allowing you to monitor the mail 
transfer.  

Progress window while downloading mail

If the Get Attention By: Alert option in the Switches... dialog is turned on, the new mail 
dialog is displayed, stating that new messages have been delivered.

New mail dialog

Depending on your settings, the In mailbox window may display.  Mail always arrives in 
the In mailbox.  Unread messages in the In mailbox are designated by a small black dot, 
or bullet, on the left side of the message summary.  Double-click anywhere on a message 
summary to open the message.  Incoming messages are saved indefinitely in the In 
mailbox until they are deleted or transferred to another mailbox.

Leave Mail on Server Option

During a mail check, Eudora normally transfers your incoming messages from your 
account on the POP server to your Macintosh, and deletes them from the POP server.  
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This may prove awkward for people who sometimes want to read 
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mail from a secondary Macintosh system.  It results in non-consolidated storage of 
messages – if you read mail through a secondary Macintosh, you wouldn’t be able to act 
on that mail from your primary Macintosh.

The Leave Mail on Server option in the Switches... dialog solves this dilemma.  If this 
option is turned on, Eudora transfers all of your new messages from the POP server to the 
Macintosh you are presently using (presumably a secondary Macintosh), while keeping 
copies of those messages in your account on the POP server. On the next mail check from 
the secondary Macintosh, Eudora ignores the copies of previously read messages and 
looks for new ones.  

If the Leave mail on server option in the Switches... dialog is turned on, the following 
progress window is displayed on your screen when Eudora transfers the new mail.

Progress window when the Leave Mail on Server option is on

When using your primary Macintosh system, you should turn the Leave Mail on Server 
option off, so that all messages (new ones as well as copies of old ones you read through 
other Mac systems) are transferred to and consolidated on the one primary system.  The 
Leave Mail on Server option should be used with care, since it can result in a buildup of 
messages on the POP server machine.

Note: Eudora looks for a Status: R header to determine if a message has been 
read.  Your POP server must cooperate for this to work; most do.

Skip Big Messages Option

If the Skip Big Messages option in the Switches... dialog is turned on, Eudora does not 
download large messages (40K or larger).  Instead, it downloads only the first few lines 
of such messages and adds a note at the bottom stating that the whole message has not 
been transferred.  This can be useful on slow connections.

Note: Eudora requires some help from your POP server to make Skip Big 
Messages work properly.  Specifically, Eudora expects your server to add 
a Status: header once Eudora has downloaded the first few lines of the 
message.  Eudora uses that line as a signal that it already has the first few  
lines and doesn’t need to download them again.  

Stopping a Mail Check

If you want to stop a mail check in the middle (because it is taking longer than 
anticipated), hold down the [command] key and type a period [.].

Opening a Mailbox to Read a Message

To open a mailbox, select the desired mailbox from the list of mailboxes under the 
Mailbox menu.  The mailbox window is then displayed.  
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Opening a mailbox window

To open a “nested” mailbox (one that is contained within a mail folder), select the 
outermost folder from the Mailbox menu (folders are designated by an arrow next to 
their names).  This displays the sub-menu of mailboxes and/or folders within the outer 
folder.  Select the desired mailbox (or continue selecting sub-folders until the mailbox 
can be selected).

Opening a mailbox in a mail folder

If any messages are stored in the mailbox, they are listed as individual message 
summaries.  A message summary usually consists of the message status and priority, the 
sender/recipient of the message, the date it was received, its size and the subject heading. 
See the “Anatomy of a Mailbox Window” section for descriptions of these fields.

Message summaries listed in the In mailbox

To open a message, double-click on its message summary, or, if the message summary is 
current (highlighted), select Open... from the File menu or press the [return] key.
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Creating Mailboxes and Mail Folders

There are two ways to create new mailboxes and mail folders.  You can create mailboxes 
and folders using the Mailboxes dialog under the Special menu (see the “Mailboxes 
Window” section), and you can create mailboxes and folders using the New... option 
under the Transfer menu (see the “Creating a Mailbox During Transfer” section).  The 
Mailboxes window is most useful if you want to create several mailboxes at one time.  
The New... option is most useful if you want to create a mailbox and simultaneously 
transfer a message or messages into that mailbox. 

Anatomy of a Mailbox Window

Mailbox windows are one of the most important elements of Eudora.

A mailbox window

Message Summaries

Each line in a mailbox window represents one message and is called a message 
summary.  To select a message summary, single-click on it.  There are several ways to 
select more than one summary.  You can select a summary and drag through the ones you 
want to select.  You can select one summary, hold down the shift key, and select another 
summary to select both summaries and all the summaries between them.  Finally, you can 
hold down the [command] key and select individual summaries.  This allows you to make 
“disjoint” selections.

A disjoint selection in a mailbox window

Mailbox Window Columns

A mailbox window (and hence each message summary) is divided into five columns:  
Status/Priority, Sender/Recipient, Date, Size, and Subject.

The Status/Priority column displays two separate items.  The first is the message status, 
which is one of the following:
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• The message has not been read (all mailboxes except Out), or is 
queueable but has not been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet able 
to be queued because it has no recipients (Out mailbox only).

R Reply has been chosen for the message.
F Forward has been chosen for the message.
D Redirect has been chosen for the message.
S The message has been sent (outgoing messages only).
- The message was transferred from the Out mailbox before being sent.

The message priority is displayed as follows:

Highest priority
High priority

(blank)
Normal

Low priority 
Lowest priority

For more information on message priorities, see the “Message Priorities” section.

The Sender/Recipient column shows the sender of the message (for incoming messages) 
or the recipient or intended recipient (for outgoing messages).

Note: Bugs in some POP servers/mail transport systems may result in Eudora 
displaying the sender of incoming messages as ???@???.  This is because 
the required From: header is missing.

The Date column displays the date and time the message was sent, or, for timed 
messages, the date and time the message is scheduled to be sent.

Note: The date is formatted according to the short date format in current use by  
your Macintosh, and the time is formatted according to the current time 
format.

The Size column displays the size of the message, in K (K = 1024 bytes).

The Subject column displays the subject of the message.  This information was typed into 
the message header by the sender.

Resizing Columns

You can resize any column in a mailbox window.  Move the mouse pointer until it is over 
the dotted column divider to the right of the column you want to resize.  The pointer turns 
into the column resize cursor.
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Column resize cursor

Simply press the mouse button, drag the divider to the position you desire, and release the 
mouse button.  The column divider moves to the new location, and the mailbox is 
redrawn.

Mailbox after resizing column

You can only shrink a column as far as its left divider.  If you do so, a double divider line 
is displayed in place of the column, and its contents are hidden.  To redisplay the column, 
drag the right divider line to the right.

Mailbox window with a hidden column

Mailbox Size Display

The lower left corner of each mailbox window displays size information for that mailbox. 
Three numbers are displayed.  The first is the number of messages in the mailbox; the 
second is the total amount of space those messages require; and the third is the amount of 
disk space that is wasted in the mailbox.  Eudora occasionally recovers this wasted space 
on its own.  To force Eudora to recover this space from all mailboxes, select Compact 
Mailboxes from the Special menu.  To compact an individual mailbox, hold down the 
[command] key and single-click on the mailbox size display.
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This mailbox contains 43 messages, which take 50K of disk space – 21K of which is wasted

Deleting a Message

As a safeguard against inadvertent deletions, two steps are required to delete a message in 
Eudora.  For any current message, choose Delete from the Message menu.  This does 
not actually delete the message, but transfers it to the Trash mailbox.  To delete messages 
from the Trash mailbox, select Empty Trash from the Special menu.  Quitting the 
program also empties the contents of the Trash mailbox when the Empty Trash on Quit 
option in the Switches... dialog is turned on.  Finally, if you want to delete just a few 
messages from the Trash mailbox, highlight them and select Delete from the Message 
menu.  Deleting a message that’s already in the Trash removes it from Eudora completely.

Also, unless the Easy Delete option in the Switches... dialog is turned on, any attempt to 
delete a message that you have never opened (or a Queued message that hasn’t been sent) 
results in Eudora asking for confirmation before proceeding with the deletion.

Warning for deleting unread or unsent messages

Compacting Mailboxes: Recovering Storage Space 

Even after a message has been deleted with the two-step process described above, the 
storage space which that message originally required is still taken.  Normally, Eudora 
recovers this space automatically when it becomes troublesome.  However, if disk space 
is very tight, you can force this to happen earlier than usual.  In order to reclaim the 
storage space, select the Compact Mailboxes from the Special menu.  To compact an 
individual mailbox, hold down the [command] key and single-click on the mailbox size 
display (see the “Mailbox Size Display” section).

Note: Eudora compacts mailboxes automatically when you close them under 
either of two conditions.  Mailboxes are compacted if the amount of 
wasted space in the mailbox is greater than the amount of space the 
messages in the mailbox use, or if the amount of space 
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wasted in the mailbox is greater than 5% of the free space on the volume that 
contains it.

Transferring a Message to a Different Mailbox

Messages may be transferred between any two mailboxes.  For any current message, 
select the mailbox to which the message should be transferred from the Transfer menu.  
The message is removed from its previous location and stored in the selected mailbox.

Transferring a message

If you hold down the [option] key while transferring a message, the message is copied 
into the new mailbox instead of transferred.  This is useful if you want to file a message 
in more than one mailbox.

Creating a Mailbox During Transfer

To create a mailbox and transfer the current message into it at the same time, select 
New... from the Transfer menu instead of the name of a mailbox.  The New mailbox 
dialog is displayed.
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New mailbox dialog

Type in the new mailbox name and click OK.  The mailbox is created and added to the 
Mailbox and Transfer menus.  The current message is also transferred into the new 
mailbox.  However, if you check the Don’t transfer, just create mailbox option, the 
mailbox is created but the message isn’t transferred into it.

You can also create mailboxes using the Mailboxes dialog under the Windows menu (see 
the “Mailboxes Window” section).  The Mailboxes window is most useful if you want to 
create several mailboxes at one time.

Creating a Mailbox Folder During Transfer

Eudora allows you to create mail folders in which you may keep one or more mailboxes 
and even other sub-folders that hold additional mailboxes.  In other words, not only can 
mailboxes be organized into folders, but folders can be contained one within another.

To create a new mail folder during message transfer, select New... from the Transfer 
menu instead of the name of a mailbox.  The new mailbox dialog is displayed.  Type the 
name of the new mail folder and check the Make it a Folder option.  Click OK to create 
the folder.

Creating a mail folder

The new folder name is displayed at the bottom of the list of mailbox names under the 
Mailbox and Transfer menus.  There is an arrow next to the name designating it as a 
folder and not as a mailbox.  Your message can’t be transferred, however, since messages 
must be in mailboxes and you have not yet created a mailbox.  Therefore, the new 
mailbox dialog is displayed again.  Now, type the name of the mailbox you want to create 
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within the newly-created folder and click OK to complete the transfer.

Eudora User Manual Reference



Reference Eudora User Manual

Mailboxes Window

Mailboxes and mail folders provide a structured way for Eudora users to organize 
received messages.  The Mailboxes window allows you to create new mailboxes and 
folders and to remove and rename them.  You may also want to move mailboxes and 
folders from one folder to another one.  

To accomplish any of these tasks, choose Mailboxes from the Special menu.  The 
Mailboxes window is displayed.

The Mailboxes window

The window has two identical listings with scroll bars, each entitled Eudora Folder (or 
whatever the name of the folder holding your mail is – see the “Mail Storage” section).  
These list the names of the mailboxes and folders you have created (folders are identified 
by an arrow to the right of the name).  This list is similar to that displayed under the 
Mailbox and Transfer menus, except that the In, Out, and Trash mailboxes aren’t 
included.  Underneath each of the lists are buttons labeled Rename, New, and Remove.  
Between the lists are two additional buttons labeled Move, each pointing from one list to 
the other. 

Double-clicking on any of the mailboxes in a list opens that mailbox window on the 
screen.  Individual messages can be selected, opened, and otherwise manipulated from 
there.

Finding the Mailbox or Folder

If the Mailbox window isn’t big enough to display all of your created mailboxes and 
folders, use the scroll bar on the right side of either list to view the rest of the mailboxes 
and folders. 

Double-clicking on a folder (denoted with an arrow to the right of its name) changes the 
current title of the list from Eudora Folder to that of the chosen folder.  The contents of 
the list also change to the names of mailboxes and sub-folders contained in the chosen 
folder.
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Opening a mail folder

To move back out of the sub-folder to the folder that contains it, select the inner folder’s 
title above the listing of its contents.  A popup menu is displayed listing the available 
folders.  Choose one of the folder names in this popup menu to change the list to reflect 
that folder’s name and contents. 

Moving back out of a mail folder

Removing a Mailbox or Folder
With the Mailboxes window open, use the scroll bar and selection tool to locate the name 
of the mailbox or folder that you want to remove.  

Note: You can perform this function using either of the two lists in the Mailboxes  
window.  It is not necessary to locate a mailbox or folder in both lists 
before deleting it.
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Once the desired mailbox/folder is found, click on it once to select it.  Then, click on the 
Remove button that is located below the list.

Starting to remove a mailbox

A dialog is then displayed asking you to confirm the mailbox removal.  Click on the 
Remove It button to remove the mailbox.

Mailbox removal dialog

If you press the [command] key while selecting from a list of mailboxes/folders, you can 
select more than one mailbox or folder simultaneously.  When you click on the Remove 
button, the mailbox removal dialog is displayed to verify the removal.  The dialog 
contains the name of the first mailbox you have selected.  If you click on Remove It, 
Eudora removes that mailbox, and then displays another dialog for the next mailbox.  If 
you click on Remove All, all of the selected items are removed without any further 
prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder in which 
other mailboxes or folders are stored, all messages/mailboxes/folders contained within 
the selected mailbox are also removed.

Removing a mailbox with messages in it
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Renaming a Mailbox or Folder

With the Mailboxes window open, use the scroll bar and mouse pointer to locate the 
name of the mailbox/folder that you want to rename.

Note: You can perform this function using either of the two lists in the Mailboxes  
window.  It is not necessary to locate a mailbox or folder in both lists 
before renaming it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click on the 
Rename button that is located below the list.  

A dialog is then displayed requesting the new name.  Type in the new name and click on 
Rename to rename the mailbox/folder.

Renaming a mailbox or folder

Creating a New Mailbox or Folder

New mailboxes and folders can be created using the Transfer menu, as described in the 
“Creating Mailboxes During Transfers” section, or they can be created using the 
Mailboxes window.

To create a new mailbox or folder, select Mailboxes from the Special menu.  Double-
click on the folder in which the new mailbox/folder is to be created to open it.  Its name is 
displayed above one of the lists, and its contents are displayed therein.

Note: You can perform this function using either of the two lists in the Mailboxes  
window.  It is not necessary to locate a folder in both lists before creating 
a new mailbox or folder inside it.

Click on the New button that is located below the list.  

Creating a new mailbox
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A dialog is displayed requesting the name of the new mailbox.
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Naming a new mailbox

Type in the new name, check the Make it a Folder option if you want to do so, and click 
OK.  The new mailbox/folder is displayed in the designated folder’s listing.  The newly 
created mailbox/folder is also added to the Mailbox and Transfer menus.

Moving a Mailbox (or Folder) from one Folder to Another

The Mailboxes window provides the means for moving mailboxes and folders to other 
folder locations.  This is why there are two lists in the window.

To begin, locate in one of the lists the folder or mailbox you want to move.  In the other 
list , find and open (by double-clicking on the name) the destination folder such that its 
name is displayed above the list, and its contents are displayed.  Then, select the mailbox 
or folder you want to move.   Now click on the Move button that points from the list 
containing the item you want to move to the list displaying the destination folder.  The 
chosen mailbox/folder is moved to its new location. 

Moving a mailbox, before and after
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Attachments

Any Macintosh document can be attached to and sent with a Eudora message.  To attach a 
document to a current outgoing message, select Attach Document... from the 
Message menu.  A standard file dialog is displayed.  Once the desired document is 
located, select it and click on the Open button to attach the document to the message. 

Attaching a document

The attached document functions like a “rider” to the E-mail message, and thus it does 
not appear within the message text.  Instead, the name of the document and the disk from 
which it was copied is displayed automatically in the Attachments: field of the message 
header.

An outgoing message with an attached document
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Note: A document cannot be attached to a message through manual editing of 
the Attachments: field.

When the message is sent, if the chosen document is not a plain (ASCII) text file, it is 
formatted in the selected attachment format (AppleDouble, AppleSingle, or BinHex) and 
sent with the message.  This allows you to send any kind of document through the mail, 
even Macintosh applications.

If the chosen document is a plain text file (and if the Always As Documents option in the 
Switches... dialog is turned off, or Always As Documents is not selected in the icon bar), 
it is not encoded in any special format before being sent, but rather it is added to your 
message as though you had typed it in manually.

Multiple Attachments

Multiple documents may be sent with a single message, but each document to be attached 
must be selected as described above.

Detaching a Document

To detach a document before the message is sent out, click anywhere on the name of the 
document in the Attachments: field of the composition window.  Then, press [delete] or 
select Clear from the Edit menu.

Receiving an Attachment

There are two primary ways you can receive an attached document from another Eudora 
user.  One way prompts you to choose what folder the attachment should be placed in and 
to assign the attachment’s name.  The other way automatically receives all attachments in 
a pre-specified folder on your disk.  Both ways are described below.

Manual Receive of Attachments
Unless you choose Automatically save attachments to in the Configuration... dialog, 
whenever you receive a message with an attachment from another Eudora user a standard 
file dialog is displayed.  Use this dialog to choose where to put the document and what to 
call it.

Manually receiving an attachment

Eudora automatically decodes the attachment, and it arrives on your disk just the way it 
left the sender’s.
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Saving Attachments Automatically
The most convenient way to save attachments is to a pre-specified folder on your disk.  
To set this up, select Configuration... from the Special menu.  In the dialog, click on 
the large button beneath Automatically save attachments to:

Starting to select an attachments folder

A dialog is displayed through which you may choose a folder in which arriving 
attachments are automatically saved.

Selecting an attachments folder

Double-click on the name of the folder into which you want Eudora to put attachments 
(its name should be displayed in the menu above the list). At this point, click on the Use 
Folder button.  

The dialog then closes, leaving the Configuration... dialog displayed.  The name of the 
folder you just selected to receive attachments is now shown in the button.  If you ever 
want to specify a different folder to receive attachments, simply click on this button and 
the dialog for choosing an attachments folder is redisplayed.  
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In order for the folder to be used, the Automatically save attachments to: option must also 
be checked.  Eudora checks this for you when you select a folder.
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An attachments folder is selected

Note: If at some future time Eudora cannot find your selected folder (perhaps 
because the volume that contained it is not available), it unchecks the 
Automatically save attachments to: option.  However, the name of the 
folder remains in the button until another folder is selected.

When invoking this option, attachments are decoded automatically and saved directly 
into the selected folder.  The name given your attachments is recorded in the message 
from which they came.  If you receive multiple attachments with the same name, a 
number is added to each attachment’s name.

Not Saving an Attachment

You may choose not to save the attached document.  This is done by clicking the Cancel 
button in the above dialog.  In such a case, the attachment is included in the body of the 
message. The document has to be saved to a file and decoded manually to appear in its 
proper format.

Note: The application “Stuffit,” among others, can be used to decode such 
documents.

Non-Eudora Users Receiving Attachments

If you send an attachment to someone who doesn’t use Eudora, the attached file is 
included at the end of the message in the chosen attachment format (AppleDouble, 
AppleSingle, or BinHex).  If the recipient does not use a Macintosh, AppleDouble is 
probably the best format as it is most usable on non-Macintosh platforms.  If the recipient 
does have a Macintosh, BinHex is the best format.  If the attachment is encoded in Bin 
Hex, however, it is not usable until the recipient has decoded it.

Note: The application “Stuffit,” among others, can be used to decode such 
documents.

Replying to, Forwarding, or Redirecting an Incoming Message

This section describes the Reply, Forward, and Redirect commands found in the Message 
menu.  These commands are different from the Reply To, Forward To, and Redirect To 
commands found in the same menu.  This latter set of commands is used with the Quick 
Recipient list (see the “Using the Quick Recipient List” section for descriptions of 
these commands).
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Replying to a Message

To reply to a current message, select Reply from the Message menu.  A new message 
window is displayed, with the original sender’s address automatically placed in the To: 
field of the header.  The original sender’s text is also 
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automatically included in the message body (prefixed by “>”  at the beginning of each 
line).  This text may be edited as needed.   Additional text can be added to the reply just 
as to any outgoing message, and the reply can then be sent or saved for further changes.

A message and its reply

An incoming message for which the Reply command has been used is identified by an 
“R” in its message summary.

‘R’ indicates that the message has been replied to

Modified Forms of Reply
There are several variations of the Reply command.

Reply all:
If you hold down the [option] key when selecting Reply from the Message menu, the 
reply message is sent to the sender of the original message and to everyone who received 
it.  This is useful for carrying on group discussions electronically.  
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However, if the Reply All option in the Switches... dialog is turned on, reply all is the 
default, and you must hold down the [option] key to reply only to the message sender.

Don’t include self:
If the Include Self option in the Switches... dialog is turned off, Eudora does not include 
your return address in the reply all.

Quote selection only:
In some cases, you may wish to respond to only a portion of the sender’s message.  This 
can be done by first highlighting the desired text in the sender’s message.  Then, hold 
down the [shift] key when selecting Reply from the Message menu.  Only the highlighted 
text is quoted in your reply message.  

Forwarding a Message

You may want to relay, or forward, messages to other users.  To forward a current 
message, select Forward from the Message menu.  A new message window is 
displayed, with your address automatically placed in the From: field of the header.  The 
original sender’s text is also automatically included in the message body (prefixed by “>” 
at the beginning of each line).  This text may be edited, and more text can be added to the 
message.  Type the address of the person to whom you want the message forwarded in the 
empty To: field of the header.  The message can then be sent or saved for further changes.

Forwarding a message
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An incoming message for which the Forward command has been used is identified by an 
“F” in its message summary.

‘F’ indicates that the message has been forwarded

Redirecting a Message

Eudora provides a way to redirect messages that you decide were more appropriately sent 
to someone besides yourself.  To redirect a current message, select Redirect from the 
Message menu.  A new message window is displayed.  The address in the From: field is 
that of the person who originally sent the message, by way of your address.  In addition, 
there are no “>” markers at the beginning of each line of the original text.  However, you 
may edit or add more text to the message.  Type the address of the person to whom you 
want the message redirected in the empty To: field of the header.  The message can then 
be sent or saved for further changes.

Redirecting a message

An incoming message for which the Redirect command has been used is identified by a 
“D” in its message summary.
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‘D’ indicates that the message has been redirected

Easy Repeat (“Canned”) Messages Using Redirect
If you find yourself sending the same message over and over again to different people, 
you can keep a “canned” copy of that message and send it easily using the Redirect 
command.  To do this, first compose a new message as you normally would, but leave the 
To: field blank.  Save the message, and, if desired, use the Transfer menu to move it from 
the Out mailbox into another mailbox (named “Canned Messages,” perhaps).  When you 
want to send the message to someone, locate the message and open it (or simply highlight 
it in the mailbox window), select Redirect from the Messages menu, fill in the To: 
field, and send the message.

Redirect and Signatures
When you use Redirect, your signature file (described in the “Creating a Signature” 
section) is not added to the message when it is sent, unless the message was originally 
created by you.  Eudora considers the message to be originally from you if the address in 
the From: field exactly matches your return address.  

Creating and Using Nicknames

When addressing messages, Eudora supports the use of nicknames in place of full user 
names.  A nickname (sometimes called an alias) is an easily remembered, shorter 
substitute for an actual E-mail address or group of addresses.  Typically, nicknames are 
created for persons with whom one has repeated correspondence, and hence serve as a 
typing and reference shortcut.  Eudora allows nicknames to be used in place of proper E-
mail addresses in the To:, Cc:, and Bcc: fields in the headers of outgoing messages.

To create, edit, or remove a nickname, select Nicknames... from the Special menu.  
The Nicknames window is then displayed.  This window is divided into three main fields. 
The Nickname: field lists all your nicknames; the Address(es): field displays a selected 
nickname’s expansion (the addresses that the nickname represents); and the Notes: field 
contains your private notes on a nickname.
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The Nicknames window

Adding New Nicknames

To add a new nickname, click on the New button.  The new nickname dialog is displayed 
prompting you for the name of the new nickname.

New nickname dialog

Type the name of the new nickname.  If you want this nickname to show up on the Quick 
Recipient list under the Message menu (see the “Using the Quick Recipient List” 
section), click on the Put it on the recipient list option.  Then, click OK.

The new nickname is displayed in the Nicknames: field of the Nicknames window, and 
the insertion point is placed in the Address(es): field.  Type the complete E-mail address 
of the person to be represented by the nickname.
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Entering an address for a nickname

If you’d like to add someone’s proper name to the address that you specify, just put it in 
parentheses after the E-mail address.

Note: Be aware that the proper name is put in the To: field of mail messages 
along with the full address.

You may also type a series of many E-mail addresses (and even other nicknames), 
separated by commas or returns, in the Address(es) section.  These multiple addresses are 
represented by the single entered nickname.  In this way, a nickname can be used for a 
group mailing list.

Using a nickname as a mailing list

Note: The Nicknames window is the only place where it is permissible to use a 
[return] to separate addresses.  Everywhere else, you must use commas.

The Notes: field can be used to enter any text you’d like to associate with a nickname, 
such as the addressee’s company, title, or phone number.
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Entering notes for a nickname

Note: The contents of the Notes field is not put in mail you send.

One nickname can point to another nickname, which can point to still another, and so on; 
eventually, however, the nickname must end in a real address or group of addresses.  For 
example, Eudora contains John in its expansion, and John is itself a nickname for 
jnoerenberg@qualcomm.com.

One nickname using another nickname

Once you’ve finished typing addresses and notes, you can click the New button again to 
make another nickname.

When finished making additions or changes, select Save from the File menu to save the 
changes.  If you close the Nicknames window without saving the changes, a dialog is 
displayed asking whether the additions/changes you just made should be saved or 
discarded.

Eudora User Manual Reference



Reference Eudora User Manual

Saving changes to Nicknames

Changing and Removing Nicknames

To change a nickname, select Nicknames from the Special menu.  Click once on the 
desired nickname in the Nickname: field to select it.  Then, click the Rename button.  A 
dialog is displayed allowing you to change the nickname.  You can also add or remove 
the nickname from the Quick Recipient list using the Rename dialog.  Just check or 
uncheck the Put it on the recipient list option.  Once the changes are completed, click 
OK.

Renaming a nickname

To change a nickname’s corresponding E-mail address(es) and notes, click once on the 
desired nickname to select it.  The addresses and notes associated with the nickname are 
displayed in the Address(es): and Notes: fields, and may be directly edited.
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Changing a nickname expansion

To remove the nickname, click once on the desired nickname to select it.  Click the 
Remove button.

When finished editing or making deletions, select Save from the File menu to save the 
changes.  If you close the Nicknames window without saving the changes, a dialog is 
displayed asking whether the additions/changes/deletions you just made should be saved 
or discarded.

Make Nickname... Command

The Make Nickname... command can be used to make a nickname in two different ways.

From the Nicknames window itself, use command-click to select several different 
nicknames, and then choose Make Nickname... from the Special menu.  The new 
nickname dialog is displayed prompting you for the name of the new nickname.  Once 
you have entered the name, click OK to create the new nickname with the selected 
nicknames in the Nicknames window as its addressees.  This is an easy way to make a 
group nickname out of existing nicknames.
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Using Make Nickname... to make a mailing list

Alternately, you can make a nickname out of the address list of a current message.  Open 
a mailbox and single-click on the desired message to make it current.  Select Make 
Nickname... from the Special menu.  The new nickname dialog is displayed prompting 
you for the name of the new nickname.  Once you have entered the name, click OK.  If 
the current message is an outgoing message, its To:, Cc:, and Bcc: fields are used for the 
nickname’s addressees.  If the current message is an incoming message, its From: field is 
used for the nickname’s addressees.  If multiple messages are current (i.e., you have 
several message summaries selected in a mailbox window), addresses are taken from 
each message and all are put in the new nickname’s expansion.

Making a nickname from current messages

Note: When an incoming message is current, Make Nickname... pretends to do a 
Reply to the current message, and then takes all the recipients from the 
reply message and uses them in the nickname expansion.  This means that 
Make Nickname... acts just like Reply in regard to the Include Self and 
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Reply All options in the 
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Switches... dialog.  That is, if the Reply All option in the Switches... dialog is 
turned on (or you hold down the option key), the nickname is made for all 
of the recipients of the messages plus the sender, not just the sender.  
Similarly, if the Include Self option in the Switches... dialog is turned off, 
your address is not included in the new nickname’s expansion.

Using the Nicknames Window to Address Mail

The To:, CC:, and Bcc: buttons in the Nicknames window can be used to start mail 
messages or to add addressees to existing current messages.  To create a new message 
from the Nicknames window, select the nickname to which you want to address the mail 
(you can select multiple nicknames by holding down the [command] key and clicking on 
each nickname).  Then, click the To: button.  

Starting a new message from the Nicknames window

A new composition window is displayed with the selected nickname(s) inserted the To: 
field.
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New composition window with addressee

Once the composition window is displayed, use the To:, Cc: and Bcc: buttons to insert 
additional nicknames into the corresponding fields.

Note: If you hold down the [option] key when addressing messages using the 
Nickname window To:, Cc:, and Bcc: buttons, the full nickname expansion  
is inserted into the appropriate message field rather than just the 
nickname.

The Nicknames window can also be used to address existing messages, or new messages 
created by selecting New from the Message menu.  Make sure the desired message is 
current (topmost), then open the Nicknames window and use the To:, Cc: and Bcc: 
buttons to address the message.

Type-to-Select in the Nicknames window

When the Nicknames window Nickname: field is selected (indicated by the bold square 
around the field), you can type the first few letters of a nickname to select that nickname. 
If the bold square isn’t around the Nickname: field, click once on the list to select it.

J O H

Type-to-select nickname

Nicknames and the Quick Recipient List

Nicknames and the Quick Recipient list are two separate entities.  Nicknames are used as 
an abbreviation for an address or a list of addresses.  The Quick Recipient list is used to 
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add addresses to messages via the Message menu.  Nicknames do 
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not need to be on the Quick Recipient list, and not everything on the Quick Recipient list 
needs to be a nickname.

However, you may have nicknames to which you often send mail, and it makes sense to 
add these nicknames to the Quick Recipient list.  This is easily done from the Nicknames 
window.

Examine the Nickname: field in the Nicknames window.  Notice that there is a margin 
between the first letter of each nickname and the edge of the field.  Now, select a 
nickname and place the mouse over the margin between the nickname and the edge of the 
field.  The cursor changes into a miniature image of a menu.  Click the mouse once and a 
bullet (•) is displayed in the margin area.  This bullet indicates that the nickname has been 
added to the Quick Recipient list.

The nickname is now on the Quick Recipient list

Click again, and the bullet disappears, removing the nickname from the Quick Recipient 
list.  The Quick Recipient list is discussed further in the “Using the Quick Recipient 
List” section.

Note: Double-clicking a nickname also puts it on or removes it from the Quick 
Recipient list.

If you rename or remove a nickname that is also on the Quick Recipient list, the name on 
the Quick Recipient list is also changed or removed.

Finish Nickname Command

The Finish Nickname command under the Edit menu is another nickname-related 
function designed to save typing in header fields.  It allows you to type only a portion of 
a nickname in the To:, Cc:, or Bcc: fields of a message, with Eudora completing the 
typing task. 

To use this option, type only the number of characters in the nickname that make it 
unique with respect to other nicknames in the appropriate field of the message header.  
Then, select Finish Nickname from the Edit menu.  The partial text of the nickname is 
automatically completed in the header field.
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For example, if you type an “S” in the To: field and you only have one nickname that 
starts with the letter S, the Finish Nickname function completes the nickname in the 
message header.
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Note: If you hold down the [option] key while finishing a nickname, the 
nickname’s expansion is inserted instead of the nickname itself.

Quick Recipient List 

It may be more convenient to address a message by selecting a nickname or full address 
from a predetermined Quick Recipient list.  This eliminates the need to type frequently 
used nicknames or addresses in the fields of outgoing message headers.  By selecting a 
nickname or address from the Quick Recipient list,  the address or nickname is 
automatically entered in the desired field.  The list may also be used to more easily reply 
to, forward or redirect messages.

Eudora uses a single Quick Recipient list that can be accessed via the New Message To, 
Reply To, Forward To, and Redirect To selections under the Message menu, the Insert 
Recipient selection under the Edit menu, and the Remove Recipient selection under the 
Special menu.

The Quick Recipient list

Creating the Quick Recipient List

The Quick Recipient list should consist of the nicknames or addresses of common 
correspondents.  To add a nickname to this list, choose Nicknames from the Special 
menu (see the “Creating and Using Nicknames” section for more details).  The 
Nicknames window is displayed.  Select the desired nickname or nicknames from the 
Nickname: field.  Then, click in the margin between the first letter of the nickname and 
the left side of the field.  This places a bullet in the margin and adds the nickname(s) to 
the Quick Recipient list.
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Adding a nickname to the Quick Recipient list

To add a full E-mail address to the Quick Recipient list, select the desired text that makes 
up the full address from any current message header.  Then, select Add As Recipient 
from the Special menu.

Adding an address to the Quick Recipient list

Using the Quick Recipient List

The Quick Recipient list is displayed when you select New Message To, Reply To, 
Forward To, or Redirect To from the Message menu.  To utilize the list, select a recipient 
using one of these commands.  Releasing the mouse button performs the action (new 
message, reply, forward, redirect) and the chosen recipient is automatically inserted in the 
To: field of the new message header.
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Starting a message with the Quick Recipient list

More than one nickname or address from the Quick Recipient list can be added to the To:, 
Cc: and Bcc: fields of any message.  To do this, first place the blinking insertion point in 
the field where you want the nickname/address to be inserted.  Then, select the desired 
recipient from the Insert Recipient list under the Edit menu.  The chosen 
nickname/address is placed at the insertion point and a comma is added (if necessary) to 
separate the new address from the ones previously placed in the field.

Removing a Quick Recipient From the List

To remove a nickname/address entry from the Quick Recipient list, select it using the 
Remove Recipient option under the Special menu.  When you release the mouse 
button, the selected recipient is deleted.

Note: Removing a nickname from the Quick Recipient list does not delete it from  
the Nicknames window, but removing a nickname from the Nicknames 
window deletes it from the Quick Recipient list.
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Finding Specified Text Within Messages

Eudora incorporates a Find function that searches for specific text within a single 
message, multiple messages, or even multiple mailboxes.  To display the Find sub-menu 
of commands, select Find from the Edit menu.

The Find sub-menu

Finding Text Within One Message

To search for text within a single message, open the message and make sure it is current.  
Then, select Find from the Edit menu and select the Find command from the sub-menu. 
The Find dialog is then displayed, with the blinking insertion point located in the text 
field.  

The Find dialog

Type the text you want to find in the text field.  When finished entering the desired text, 
click the Find button.

Starting at the insertion point of the open message, Eudora searches the current message 
for the specified text.  If no match is found, the not found alert is displayed.
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Unsuccessful search

If the search is successful, the message is scrolled to the first point where the match is 
found and the matching text is highlighted.

Successful search

To continue searching in the same message for the next occurrence of the text, click the 
Find button in the Find dialog, or select the Find Again command from the Find sub-
menu.  These commands are equivalent and limit the search to the same message.  
Repeating these commands cycles through the matches in the open message only.

Use the Find button or Find Again command  to search within the topmost message only
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Enter Selection Command
If you don’t want to actually type the text in the Find dialog (for example, the text is very 
long or complex), highlight it in an existing message, and then select Enter Selection 
from the Find sub-menu.  This automatically inserts the selected text at the insertion 
point in the Find dialog.  Then, select the Find command from the Find sub-menu to 
start the search.

Finding Text Among Multiple Messages and Mailboxes

The Next, Next Message, and Next Mailbox commands are located in the Find sub-menu 
(under the Edit menu) or as buttons in the Find dialog.  

The Find dialog

Next Command
The Next command allows you to search for the next match of the specified text until it is 
found either in the same message or among all messages in the current mailbox.  

Use Next to find the next occurrence of the text string in or after the topmost message

Note: The Next command initiated in an open mailbox (even with message[s] 
selected) searches for the specified text among all messages contained in 
that mailbox.  The search begins with the first selected message.

Next Message Command
The Next Message command begins the search at the message after the current message.  
Eudora continues to search until it finds a matching character string, even if it has to open 
more than one message or a new mailbox.
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Use Next Message to skip the rest of the occurrences of the text string in the current message  
and search the next message(s)/mailbox(es)

Next Mailbox Command
The Next Mailbox command begins the search for the specified text in the mailbox 
following the current mailbox.  The search is conducted among all messages in that 
mailbox and any subsequent mailboxes, including the In, Out, and Trash mailboxes.  The 
search includes all mailboxes, even if they are contained in mailbox folders or sub-
folders.

Note: Mailboxes are searched in the order they are listed under the Mailbox 
menu until the current mailbox is reached.

Use Next Mailbox to skip the rest of the occurrences of the text string in the current mailbox and  
search the next mailbox(es)

Note: When the character string is found in a message, the mailbox containing 
that message is checked in the Mailboxes menu.  This identifies the 
location of the message.

Summaries Only, Match Case

If you know the text you are searching for is included in a message summary, check the 
Summaries Only option in the Find dialog.  When you click the Find button, Eudora 
searches for the text only in the sender and subject fields of message summaries as they 
appear in mailbox windows.  Eudora searches much faster when this option is checked.
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The Summaries only option makes Eudora search message summaries only

Normally, Eudora ignores capitalization when searching.  If you want Eudora to consider 
capitalization when searching, check the Match case option in the Find dialog.  When this 
option is checked, Eudora searches for exact matches of character strings, including any 
capitalization.

The Match case option makes Eudora care about capitalization

Stopping a Find

If you want to stop Eudora from continuing a search, hold down the [command] key and 
type a period [.]. 
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Sorting Messages Within Mailboxes

It is possible to sort the message summaries in a mailbox window according to their 
status, priority, sender, date, or subject.  These commands are listed in the Sort sub-menu 
under the Edit menu.

The Sort sub-menu

To use any of these commands, first open the mailbox to be sorted.  Then, select the 
appropriate command from the Sort sub-menu.  The mailbox’s messages are sorted when 
the mouse button is released.

Eudora sorts in ascending order; the smallest item first. To sort in descending order, hold 
down the [option] key while choosing the desired command from the Sort sub-menu.

Tip: Eudora’s sorting algorithm is “stable.”  This means that sorting on a 
particular column leaves items of the same value in the same order as they  
were before the sort.  This feature allows you to sort based on multiple 
criteria by using multiple sort commands.  For example, if you want your 
messages sorted by subject, and within each subject you want messages 
sorted by date, first choose Sort by Date, then Sort by Subject.

Note: Sometimes Eudora does not sort by date properly.  This happens if the 
mail was stored under an old version of Eudora, and the table of contents 
was rebuilt, or the messages have incorrectly formatted date fields or 
unknown or incorrect time zones.
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Saving A Message to a File

Eudora allows you to save a current message(s) to a separate text file on your Macintosh 
system.  To do this, first display the desired message or highlight its summary in the 
mailbox window.  Then, select Save As... from the File menu.  The Save As dialog is 
displayed allowing you to choose a name and location for the file.  

The Save As dialog

Note the two options at the bottom of the dialog.  Guess Paragraphs instructs Eudora to 
remove extraneous carriage returns from the message, leaving returns only at the ends of 
paragraphs.  In addition, it converts multiple spaces into tabs. 

Include Headers instructs Eudora to retain the message’s header information in the saved 
document.  If this is unchecked, only the body of the message is saved.   

Once you’ve made your choices, click on the Save button in the dialog.   

Saving a message to a text file

If you select multiple messages from a mailbox window and select Save As..., all of the 
messages are saved to a single file.
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Using “Save As...” to save several messages to one file

Tip: When Eudora receives a very large message from the POP server, it splits 
that message into multiple smaller messages. If you need to reassemble 
the original message, use the Save As... command.

Choosing an Application for Saved Messages

When you save a message to a file using the Save As... command, the new text file is 
formatted as basic ASCII text in a Macintosh document.   The document type is 
determined by the program you select using the Application TEXT files belong to setting 
in the Configuration... dialog.  

To do this, select Configuration... from the Special menu.  The Configuration... dialog 
is then displayed.  

The Configuration... dialog
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Near the bottom of the dialog, click the large button beneath the Application TEXT files 
belong to prompt.  An alert is displayed prompting you to choose the application you 
want to use to open messages saved as text files.  A standard file dialog is also displayed. 
Using this dialog, search through your disk to locate the desired application (probably 
your favorite word-processing program).  Select the application and then click Open.

Selecting an application to open the files Save As... creates

The selected application is then displayed in the Configuration... dialog.

The desired application is now selected
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Resending Rejected Messages 

Mail Transport Agents are computer programs responsible for routing E-mail messages 
through networks.  If for some reason an E-mail message can’t be delivered to an 
intended recipient, these programs return the message to the original sender.  A message 
is typically rejected because of an error in the recipient’s address, although many other 
reasons are possible.

The message sent back from the mail system usually includes cryptic information that 
may allow you to determine the reason for the message being rejected.  It also includes 
the text of the original message.  

A rejected message

Eudora deletes the error messages and added text and recovers the original message so 
that you can make any corrections and resend it.  To do this for the current message, 
select Send Again from the Message menu.  This eliminates the inserted extra text 
and reformats the message as it originally appeared.   You can then make changes or 
additions and resend the message, if desired.

A rejected message, restored
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Message Priorities

Eudora allows you to assign priorities to your messages.  These priorities are for 
sender/recipient reference purposes only, and they do not affect the way Eudora handles 
the messages. 

There are five priority levels available, each represented by a small icon.  Priorities range 
from 1 (highest) to 5 (lowest).  Priority 3 is assumed for messages that have no assigned 
priorities, and it is not displayed.

Highest priority
High priority

(blank)
Normal

Low priority 
Lowest priority

Message priorities are displayed in the Status/Priority column of the mailbox window.

Message priorities displayed in the mailbox window

To change the priority of a message, open the message and choose the desired priority 
from the Priority popup menu on the icon bar.  The selected priority icon is then 
displayed in the popup window.
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Assigning a priority to a message

You can also change the priority of the current message(s) by holding down the 
[command] key and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).

When you receive mail with a priority other than Normal, Eudora adds an X-Priority: 
header to the mail.  The header lists the assigned priority.

An incoming message with a pre-assigned priority

Note: All new messages are created with Normal priority, even replies to 
messages whose priority you have changed.  The exception to this is that, 
if the sender of a message gives it a priority other than normal, Eudora 
insists on giving your reply the same priority.  You can, however, change 
the priority of your response by re-assigning it manually.
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Editing Message Subjects

Sometimes the subject of a message is not clear or descriptive.  Eudora allows you to edit 
the subject of any incoming message.

Note: After the are sent, the subjects of outgoing messages (messages sent by 
you) cannot be edited.  However, prior to being sent, outgoing message 
subjects can be changed by editing the Subject: field in the message 
header.

To edit the subject of an incoming message, open it from its mailbox window.  Notice 
that the subject is displayed below the title bar and above the message proper.  You may 
edit this text as you would any other text.  When editing is complete, press Enter or 
close the message.  The new subject is displayed in the message summary.  The contents 
of the Subject: field of the message header remain unchanged.

Editing the subject of an incoming message
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After Editing the subject
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Note: If you reply to the message, the original subject is used for the reply, not 
your changed subject.  This gives you the freedom to put information 
useful to you into the summary, without fear of your private notes being 
revealed to your correspondents.

Printing

Eudora can print a current message or messages, a plain text window, or the contents of 
the Ph window.  To print from within Eudora, select Print... from the File menu with the 
message or item displayed.  If you have text selected in any of the above windows, you 
can print just the selected text using the Print Selection... command under the File 
menu.

Eudora automatically prints headers and footers on each page, giving the window title, 
page number and your return address.

Using the Ph Window

Eudora can access two different directory services, Ph and Finger, via the Ph window.  To 
display the Ph window, select Ph from the Special menu.

The Ph window

The Ph window has two buttons (one for Ph and one for Finger), and two text fields (one 
where you type your query, and one where you see the response).

Using Ph
To use the Ph protocol, the name of a Ph server must be entered in the Ph Server field in 
the Configuration... dialog.  To use Ph, type the name of the person you want to look up 
in the query field and click on the Ph button.  The server’s response is displayed in the 
response field.
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A Ph query and its response

Note: You can type any Ph command in the query field, except login commands 
or commands requiring login.  For more information about the Ph server 
source code, see Appendix A.

Using Finger

To use the Finger protocol, type your query into the query field.  This query should be in 
the form “name@domain.”  If you omit the “@domain” segment, Eudora assumes you 
mean your SMTP server host.  Once the name is entered, click on the Finger button.

The finger query is sent to the host specified in the “@domain” part, and the response is 
displayed in the response field.

A Finger query and its response
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Creating a Signature

A “signature” is a brief message automatically added by Eudora to the end of outgoing 
messages.  It should consist of a few lines giving the sender’s full name and E-mail 
address.  Other pertinent details, such as phone number, postal address, or place of 
employment are also sometimes included.

To create the signature, select Signature from the Special menu.  A blank Signature 
window is displayed.  Type your signature text in this window.

Typing a signature

When you are finished typing the signature, close the Signature window.  An alert is 
displayed asking if you want to save the changes to your signature.  Click Save.  You 
may modify your signature at any time by repeating this procedure.

In order to activate your signature on an outgoing message, click on the signature icon on 
the icon bar.  

Activating your signature in the icon bar

The signature text is not displayed at the end of messages you create, but your recipients 
see it.
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Configuration... Dialog

In order for Eudora to work correctly, the program must be configured by providing it 
with some basic though important information.  To enter this information, select 
Configuration... from the Special menu.  The Configuration... dialog is displayed.  

The Configuration... dialog

The Configuration... dialog is divided into three segments: top, middle and bottom.  Each 
of the fields in the dialog is described below.  The default settings are listed in brackets 
after the name of each Configuration setting.  

Note: In order for Eudora to function correctly, the correct information must be 
entered into the fields in the top segment of the Configuration... dialog.  
New users can safely ignore all of fields below the top segment.

The top segment of the Configuration... dialog

POP account: [none]

To receive mail with Eudora, you must have an account on a computer that runs a POP 3 
server.  This is the account to which your E-mail messages are delivered before they are 
transferred to the Eudora program on your Macintosh.  Enter your login name for this 
account, followed by an “@” sign and the (domain) name of the computer.

For example, if your login name for your POP account is “carolyn,” and the name of the 
computer is “uxh.cso.uiuc.edu,” type carolyn@uxh.cso.uiuc.edu in this field.
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Note: If you use UUCP as your mail transport, see Appendix F.

Real Name: [none]

Enter your real name here.  It is placed in parentheses after your return address in your 
outgoing mail.  It is also displayed in the Sender column of messages you send.

Connection Method: [MacTCP]

If you are using Eudora via a network connection, select MacTCP (meaning you are 
using MacTCP software for communications).  If you are using Eudora via a modem, 
select Communications Toolbox (meaning you are using Communications Toolbox 
software for communications).  If you don’t want Eudora to attempt to make any 
connections, select Offline.

The middle segment of the Configuration... dialog

SMTP Server: [none]

To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server program 
is necessary.  You need not have a login on this computer, but you must have access to it 
through your network.  If the computer on which you have your POP account is also an 
SMTP server, leave this field blank.  Otherwise, specify the name of the computer which 
you want to use as your SMTP server.

Note: If you use UUCP as your mail transport, see Appendix F.

Return Address: [none]

Normally, Eudora uses your POP Account as your return address.  If you wish to use a 
return address other than your POP account, enter it here.

Important: If you do enter an address in this field, first test the address to be 
sure that mail sent to it is indeed delivered to you.  If you use an invalid 
return address, no one can reply to your mail.

Check For Mail Every  ?  Minute(s) [none]

If you enter a number in this field, Eudora checks your POP server for new mail at 
regular intervals and transfers any mail addressed to you to your Macintosh.  The number 
you enter specifies the number of minutes between checks of the POP server.  It’s a good 
idea to set this at no less than 15 minutes.  Checking mail more frequently puts an 
unnecessary drain on your POP server.  This option only works when Eudora is running.  
Leaving this field empty disables automatic checking.

Ph Server: [none]

Enter the host name of your Ph name server here.
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Note: For more information on Ph servers, see Appendix A.
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Dialup Username: [none]

If you use Eudora with the Communications Toolbox, and you have a secondary user 
name for use during the dialup process, enter it here (this might be used as your login 
name to a terminal server, for example).  See Appendix D for details regarding how this 
field may be used.

The bottom segment of the Configuration... dialog

Message Window Width: [none]

This field specifies the width of new and received message windows (in characters).  If 
you leave this field blank, the default value is 80.  This setting has no effect on what your 
mail looks like when it is sent.  When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the 
width of the “0” character.

Message Window Height: [none]

This field specifies the height of new and received message windows (in lines).  If you 
leave this field blank, the default value is 20.

Note: If the Zoom Windows option in the Switches... dialog is turned on, 
received messages window heights are automatically adjusted to the 
length of the message text.

Screen Font, Size: [Mishawaka]

This popup menu allows you to select a screen font to be used for displaying the text of 
your Eudora messages and mailbox windows.  Type the size (in points) of the font you 
want to use in the Size field.

Printer Font, Size: [Courier]

This popup menu allows you to select a font to be used when you print messages using 
the Print... command.

Application TEXT files belong to: [TeachText]

When you choose Save As... from the File menu, Eudora creates a Macintosh document 
that is saved for the application named in this field.  That is, when you double-click the 
saved file, this application is used to open it.  You may want to set this option to your 
favorite word processing program.  To change the setting, single-click on the application 
name button (the default is TeachText).  A dialog is displayed allowing you to select the 
application (see the “Choosing an Application for Saved Messages” section). 
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Automatically save attachments to: [off, none]

If this option is checked, Eudora automatically places file attachments that come with 
messages into the specified folder.  To change the setting, single-click on the application 
name button (the default is blank).    A dialog is displayed allowing you to select the 
folder (see the “Saving Attachments Automatically” section).  

Switches... Dialog

You may tailor many aspects of Eudora to your own needs and preferences.  Some of 
these are set with the Configuration... dialog described in the previous section.  Others are 
set with the Switches... dialog.  If the setting can be either on or off, it’s in the Switches... 
dialog; if a choice beyond on or off is required, it’s in the Configuration... dialog.  To 
display the Switches... dialog, select Switches... from the Special menu.

The Switches... dialog

The Switches... dialog is divided into seven groups of options, with a descriptive heading 
above each group.  A check in the box next to the option indicates that the option is on.  
Each of the options is described below.  The default settings are listed in brackets after 
the name of each option.

Composition: Options

Many of the Composition: options can be turned on and off for individual messages using 
the icon bar displayed at the top of the message composition window.  However, setting 
them here establishes these settings as the icon bar defaults for all new composition 
windows. 

May use QP [on]
If May use QP is on, Eudora uses quoted-printable encoding when necessary, such as 
when messages that contain long lines of text or special characters are sent.  If this option 
is off, quoted-printable encoding is not used.
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Word Wrap [on]
If Word Wrap is on, a carriage return is not required at the end of each line of type in an 
outgoing message.  Eudora automatically wraps text to the next line, with line breaks at 
roughly 76 characters per line.  This makes your mail more legible to recipients using 
line-oriented mail systems.  It is strongly recommended that you turn this option on.

Tabs in Body [on]
If Tabs in Body is on, hitting the [tab] key within the message body results in Eudora 
inserting enough spaces to move the insertion point to a multiple of 8 characters from the 
start of the line.  This mimics the way tabs work on many terminals.  If this option is off, 
hitting the [tab] returns the cursor to the To: field of the message header.

This option also controls the handling of tabs in text that is pasted into the message 
window and in plain text attachments that are not sent as documents.  If Tabs in Body is 
on, tabs in such texts are replaced with the above mentioned number of spaces, as though 
you had typed them in.

This option also controls what Eudora does with tab characters that appear in mail 
downloaded from your POP server.  If the option is on, Eudora replaces these with the 
appropriate numbers of spaces, like it does for typed or pasted text.

It is suggested that you keep this option turned on.  Otherwise, you may get messy results 
when receiving mail that contains tab characters.

Keep Copies [off] 
If Keep Copies is on, a copy of each sent message is kept in the Out mailbox (their 
summaries are marked with an “S” in the Status/Priority column of the Out mailbox 
window).  If this option is off, Eudora moves outgoing messages to the Trash mailbox 
after they are sent.

Use Signature [on]
If Use Signature is on, Eudora automatically attaches your signature file (if you have one) 
to the end of outgoing messages.

Reply to All [off]
If Reply to All is on, selecting Reply from the Message menu creates a message 
addressed not only to the sender of the original message, but also to all of its recipients.  
If the option is off, Reply addresses the new message only to the sender.

You can use the [option] key to reverse this setting for any given reply.  That is, if this 
option is off, holding down the [option] key while choosing Reply replies to all, and vice-
versa.

Note: This option setting also affects the Make Nickname command (see the 
“Make Nickname... Command” section).

Include Self [off]
If Include Self is on, when you do a reply all (as described above) your address is left in 
the address list of the new message and you receive a copy of your own reply.  If this 
option is off, your address is removed from the reply message.

To determine who you are, Eudora uses the “me” nickname, if you have one.  If not, it 
uses the contents of the POP Account and Return Address fields from the Configuration... 
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dialog.
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Note: This option setting also affects the Make Nickname command (see the 
“Make Nickname... Command” section).

Send Attachments: Options

These options define the way attachments are sent.

Always As Mac Documents [off]
If Always As Mac Documents is on, attachments sent between Macintoshes are kept in 
their original Macintosh formats.  When sending a document to another platform, turning 
this option off allows Eudora to convert the attachment into the format most likely to be 
understood by other platforms.

Encode With [Bin Hex]
This two-position option allows for the selection of what format documents you attach to 
outgoing messages are encoded in: AppleDouble or Bin Hex.  AppleDouble is best for 
recipients with MIME; Bin Hex is most compatible with old Macintosh mailers and 
previous versions of Eudora.

Checking: Options

These options determine the way Eudora checks for and receives mail.

Save Password [off]
If Save Password is on, you never have to enter your password to check your mail (even 
if you quit Eudora and restart it) because your password is stored on your Macintosh.  
Only use this option if your Macintosh is in a secure place.

Leave Mail on Server [off]
Eudora normally transfers your incoming messages from your account on the POP server 
to your Macintosh, and deletes them from the POP server.  If Leave Mail on Server is on, 
Eudora transfers incoming messages to your Macintosh and also keeps copies on the POP 
server (see the “Leave Mail on Server Option” section).

Skip big messages [off]
If Skip Big Messages is on, Eudora does not download the entire texts of very large 
messages from the POP server, but only downloads the first few lines.  This can be useful 
on slow connections (see the “Skip Big Messages Option” section).

Sending: Options

These options determine the way Eudora sends mail.

Send on Check [on]
If Send on Check is on, Eudora automatically sends any messages that are queued in the 
Out mailbox whenever it checks the POP Server for new mail. 

Fix curly quotes [on] 
If Fix curly quotes is on, Eudora replaces all “smart” quotes in message text or 
attachments with "conventional" quotes prior to sending the message/attachment.  The 
“smart” quotation marks are special characters, and this option allows messages to be 
sent without using quoted-printable encoding. 

Note: If your recipients have MIME, there’s no reason to use this option.  Only 
turn it on if most of the people you correspond with don’t use MIME.
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Immediate Send [on]
If Immediate Send is on, the rightmost button in the icon bar of the message composition 
window is labeled Send.  Clicking on this button immediately sends the message to the 
POP server.  If this option is off, the button is labeled Queue 
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and clicking on it places the message in the Out mailbox marked ready for delivery (Q).

Get Attention By: Options

These options determine what Eudora does when it is running in the background and 
wants your attention, or when new mail arrives.

Alert [on]
If Alert is on, Eudora uses an alert to notify you when new mail is received.

Sound [on]
If Sound is on, Eudora makes a noise when it needs you.  There are two different sounds, 
one for the arrival of mail and one for everything else.

Flash Menu Icon [on]
If Flash Menu Icon is on, Eudora flashes an icon in the menu bar when it needs you.  
Eudora uses two different icons, a Mail flag when you have new mail and an envelope 
with an exclamation point in it for everything else.

The new mail and attention icons

Open “In” Mailbox [on]
This option applies only to the arrival of new mail.  If Open “In” Mailbox is on, Eudora 
automatically opens the In mailbox when new mail arrives.  It also scrolls to the end of 
the mailbox and selects the first unread message of the last unread batch of messages, or 
FUMLUB.  If this option is off, Eudora doesn’t open the In mailbox when new messages 
arrive.

Switch Messages With: Options

These options allow you to activate the Macintosh keyboard arrow keys as a method of 
toggling through messages.

Plain Arrows: [off]
If Plain Arrows is on and there is a message window open on the screen, the Macintosh 
keyboard arrow keys can be used to close the current message and open the next or 
previous message in the mailbox.  The up or left arrow key opens the previous message; 
the down or right arrow key opens the next message.  If this option is off, the arrow keys 
can be used to move the insertion point in messages.

Note: Even if Plain Arrows is on, the arrow keys do not switch messages if there 
is a message composition window topmost on the screen.

Cmd-Arrows: [on]
If Cmd-Arrows is on, message switching using the arrow keys (as described in the “Plain 
Arrows” section above) is permissible only when the [command] key is depressed.

Note: The Cmd-Arrows keystrokes do work when composition windows are open  
on the screen.

Miscellany: Options

These options control miscellaneous Eudora functions.
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Show All Headers [off]
If Show All Headers is on, Eudora displays the complete header, including routing 
information, with the message.  If this option is off, Eudora withholds this additional 
information.

Note: If you want to see all headers for just one incoming message, close the 
message and reopen in with the [option] key held down.

Zoom Windows [off]
If Zoom Windows is on, new mailbox and message windows automatically open to their 
“zoomed” size.  The zoomed size is computed on a window-by-window basis.  For 
mailbox windows, zoomed size is just wide enough to display the widest summary, and 
just long enough to display all the summaries (but no longer than the Macintosh display 
screen).  For message windows, zoomed size is just long enough to display all of the 
message(but no longer than the Macintosh display screen), and as wide as the Message 
Window Width setting in the Configuration... dialog.  Composition windows zoom to the 
height specified by the Message Window Height setting in the Configuration... dialog.

Easy Delete [off]
If Easy Delete is on, Eudora does not alert you when you are deleting messages you 
haven’t read or transferring queued messages out of the Out mailbox.

Mailbox Superclose [off]
If Mailbox Superclose is on, closing a mailbox window closes all open messages from 
that mailbox.

Empty Trash on Quit [on]
If Empty Trash on Quit is on, Eudora empties the Trash mailbox whenever you quit the 
application.  If this option is off, Eudora only empties the Trash when you select Empty 
Trash from the Special menu.

Note: If you want to remove some messages from the trash but don’t want to 
empty it entirely, highlight the summaries you want to delete and select 
Delete from the Message menu.  The selected messages are deleted.

Easy Open [on]
If Easy Open is on, deleting or transferring the current message opens the next message 
in the mailbox, but only if it is unread.

Show Progress [on]
If Show Progress is on, Eudora displays a Progress window at the top of your screen to 
advise you of progress made when making a network connection, transferring mail or 
some other long operation.

Auto-Ok [on]
Many network problems are temporary. When a problem occurs while Eudora is 
transferring or checking your mail, you are notified in the same way you would be if you 
were receiving new mail (see the “Get Attention By: Options” section). If Auto-Ok is on, 
these notifications automatically go away after a couple of minutes. This allows Eudora 
to try the communication again. This setting is most useful if you have a non-zero value 
for the Check for mail every ? minute(s) setting in the Configuration... dialog.

Note: Turning this option on may cause some Communications Toolbox 
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connection tools to give you less progress information and feedback.
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Balloon Help

Eudora has extensive Balloon Help.  From the Balloon Help menu, choose Show 
Balloons to turn this function on.  Move the mouse pointer to a Eudora menu selection 
or item on the screen to display a brief description of that item (see the example below).  
When you no longer require assistance, choose Hide Balloons to turn Balloon Help off.

Note: If you have an extended keyboard with a [help] key, it can be used to turn 
Balloon Help on and off.

Help balloon example

It’s possible to turn balloon help on even when a dialog is displayed. If you’re not sure 
how to respond to a dialog, try balloon help.

Quitting Eudora

To quit the Eudora program, select Quit from the File menu.  If you have queued 
messages, or timed messages due to be sent in the next 12 hours, you are asked if you 
want to send them (see the “Quitting with Queued Messages” section).  If the Empty 
Trash on Quit option in the Switches... dialog is turned on, quitting Eudora also empties 
your Trash mailbox.
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Mail Storage

The first time you start Eudora, it creates a Eudora Folder within your System Folder.  
Even though you do not need to access the Eudora Folder during normal operation, this 
section is provided to show you where Eudora stores your mailboxes and messages.

Eudora Settings

Your Configuration and Switches information is saved in the Eudora Settings file, along 
with your Quick Recipient list and the list of open windows (Eudora reopens the 
windows the next time you start the program).

Eudora Nicknames

Your nicknames are saved in the Eudora Nicknames file.

Note: This file is a plain TEXT file in UNIX “.mailrc” format.

In, Out, and Trash

These files hold your mail.  You’ll see files like these for every mailbox you create.

Note: These files are in UNIX mail format.

In.toc, Out.toc, and Trash.toc

These files are the tables of contents for your mailboxes.  They make it much faster for 
Eudora to access your mail.  You’ll see files like these for every mailbox you create.
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Eudora Log, Old Log

Eudora keeps records of all mail transfers.  These records are kept in the Eudora Log and 
Old Log files.  The Old Log file is overwritten and a new Eudora Log file is created when 
the Eudora Log file reaches its approximately 100K maximum size.

System 7 Aliases

Eudora supports the use of aliases for mailbox and .toc files that, for some reason, you 
have moved to a location outside the Eudora Folder.  This allows you to open these 
mailboxes from within Eudora.  Place Eudora aliases in the Eudora Folder or a sub-folder 
within the Eudora folder.

Sharing a Macintosh with Other Users

If you are sharing a Macintosh with other users, make a copy of the Eudora Folder for 
each user.  The copies can be named whatever you like, and put anywhere you like, 
including on floppies or network volumes.  To tell Eudora which folder to use, launch 
Eudora by double-clicking on the Eudora Settings file in that folder.

Sharing one Macintosh among multiple Eudora users
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A Word About Memory

Eudora alerts you if it is running low on memory.

A low memory alert

When this alert is displayed, quit Eudora and assign it additional memory.  To do this, use 
the Finder to locate the Eudora application file and single-click on it to select it.  Select 
Get Info from the Finder’s File menu to display the Eudora Info dialog.  Type the 
amount of memory you want Eudora to have in the Current size field.  Then, close the 
window and restart Eudora.

Changing Eudora’s memory size

You can see Eudora’s estimate of how much memory it needs at any given time by 
choosing About Eudora... from the Apple menu with the Eudora application running.  
Eudora estimates the amount of memory it needs based on your open windows and the 
size of the In, Out, and Trash mailboxes (which are constantly in use).  The best way to 
reduce how much memory Eudora needs is to clean up these mailboxes regularly or use 
other mailboxes for long-term mail storage.
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Note: There’s no harm in giving Eudora more memory than it asks for.  Eudora 
is giving you the minimum suggested memory when it suggests size.
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Summary of Eudora Menu Commands

File

This menu provides basic file and mail program functions.

New Text Document
Create a new text file.

Open...
Open the selected message summary, or open a text file, or 
open a Eudora Settings file.

Close
Close the current window.

Save
Save changes to the contents of the topmost window.  This 
applies to composition windows, text windows, and the 
Nicknames window.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.

Page Setup...
Set printing options.

Print...
Print the current message(s), text window, or Ph window.

Print Selection...
Print the current selection from a message, text window, or Ph 
window.

Quit
Quit the Eudora application.
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Edit

This menu provides text editing and sorting tools.  

Undo
Reverses the last editing action taken on a piece of text.

Cut
Delete selected text and place it on clipboard.

Copy
Copy selected text and place it on clipboard.

Paste
Place contents of clipboard at chosen insertion point in 
message.

Paste as Quotation
Place contents of clipboard at insertion point, with ‘>’ 
characters at the beginning of each line to denote quoted text.

Clear
Delete selected text.

Select All
Select entire contents of message or mailbox.

Show Insertion Point
Scroll selection or insertion point into view.

Wrap Selection
Insert returns into the current selection, in the same way as 
Eudora does when it sends mail.  With the [option] key, unwrap 
text the way Save As... does when Guess Paragraphs is turned 
on.

Finish Nickname
Complete the partial text of a nickname in the field of a 
message header.

Insert Recipient
Insert the chosen nickname/address from the Quick Recipient 
list at the insertion point.

Find
Search for designated text or a character string within 
message(s).

Sort sub menu
Sorts message summaries in a mailbox.  Hold down the 
[option] key to reverse the order of the sort.
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Mailbox

This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open mailbox where incoming messages are stored until 
deleted or transferred to another mailbox.

Out
Open mailbox where messages you compose are stored, and 
where queued messages are held until actually sent, and where 
copies of sent messages may be initially stored.

Trash
Open mailbox where deleted messages are stored. 

[Your Mailboxes]
Mailboxes you create are also displayed in this menu.
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Message

This menu lets you create and delete messages.

New Message
Open new message composition window.

Reply
Reply to the sender of the current message.

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but make the 
return address be the person who originally sent the message.

Send Again
Resend a message rejected by the mail system.  Be sure to fix 
whatever caused the problem before you queue the message.

New Message To
Send a message to someone on the Quick Recipient list.

Reply To
Reply to the current message, but send the reply to someone on 
the Quick Recipient list.

Forward To
Forward the current message to someone on the Quick 
Recipient list.

Redirect To
Redirect the current message to someone on the Quick 
Recipient list.

Queue For Delivery
Save the message in the Out mailbox and mark it as queued, or 
ready to be delivered.

Change Queueing...
Queue a message, unqueue a queued message, or set a message 
for timed send.

Attach Document
Attach file(s) to the current message.

Delete
Transfer the current message to the Trash mailbox; also used 
for deleting messages from the Trash mailbox.
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Transfer

This menu lets you transfer current message(s) to the selected mailbox.

In
Transfer the current message(s) to the In mailbox.

Trash
Transfer the current message(s) to the Trash mailbox. 

New...
Display New Mailbox dialog to create a new mailbox; current 
message(s) may be transferred into that mailbox. 

[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that 
was previously created by you.
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Special

This menu provides additional Eudora functions.

Ph
Display the Ph window.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Select a recipient from this menu and the recipient is removed 
from the Quick Recipient list.

Empty Trash
Delete all messages from the Trash mailbox.

Compact Mailboxes
Reclaim unused space in mailboxes.  

Mailboxes
Display the Mailboxes window.

Configuration...
Display the Configuration... dialog.  

Switches...
Display the Switches... dialog.

Communications...
Display the Communications Toolbox settings (not needed 
when using MacTCP).

Signature
Display the Signature window.

Nicknames
Display the Nicknames window.

Make Nickname...
Create a nickname for an address or addresses in the current 
message.

Forget Password
Make Eudora ask for your password the next time it checks for 
mail.

Change Password
Change your password on the POP server computer.  This 
requires a special server.
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Window

All Eudora window titles are listed in this menu.  Select one to open it or bring it to the front.

Send to Back
Send the topmost current window to the back of all displayed 
windows.

[Mailbox Windows]
Toggle between open mailboxes.
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